


The Font
Dialog Box

The Font dialog box provides additional character formats and
effects. You might want to use the Font dialog box if the
Formatting toolbar is not displayed, if you need formatting
commands that are not available on the Formatting toolbar, or if
you are choosing a number of different formats at the same time.

You are going to open a new document and then use some of the
options on the Font dialog box.

1. Be sure the Show/Hide Paragraph button is
activated, Nor mal is cho sen on the View menu, and
the Word set tings match those on pages xiii - xv.

2. There should be a new document on the screen.

3. Type: Experimental Text

4. Select the text that you just typed.

5. On the Format menu, choose Font.

The Font dialog box appears. Notice that it contains
three tabs — Font, Character Spacing, and Text Effects.
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6. Verify that the Font tab is displayed.

Notice the first three groups — Font, Font style, and
Size. These perform the same functions as their
equivalent buttons on the Formatting toolbar. Notice 
the Preview box. This box displays whatever is
highlighted in the document — in this case,
Experimental Text. If nothing is highlighted, the name 
of the current font is displayed.

7. In the Font style list box, click Italic.

Notice that the text in the Preview box is italic.

8. In the Font style list box, click Bold.

Notice that the text in the Preview box is bold.

9. In the Font style list box, click Bold Italic.

Notice that the text in the Preview box is bold and
italic.

10. In the Font style list box, click Regular.

The text returns to its regular formatting.

11. You are going to look at some of the formatting
available in the Effects section.

Click the Strikethrough check box.

Notice the line through the text in the Preview box.
Strikethrough is used to identify text recommended
for deletion but needing approval.

12. Click the Strikethrough check box to turn it off.

13. Click the Superscript check box.

Notice that the text in the Preview box is smaller and
raised up. Superscript is useful for creating effects
such as x2.

14. Click the Superscript check box to turn it off.

15. Click the Subscript check box.

Notice that the text is smaller and lowered
somewhat. Subscript is useful for creating effects
such as H2O.

16. Click the Subscript check box to turn it off.

17. Click the Hidden check box.

Lesson 9 - More Character Formatting 99



Although nothing happened in the Preview box, the
text will appear in the document 
with little dots under it.  
Text that is formatted with the 
Hidden effect will not be printed (unless you
specifically request it), nor will it be counted in the
character and line count. Hidden text is often used
to leave notes to yourself or others about the
document.

18. Click the Hidden check box to turn it off.

19. Click the Small Caps check box.

If all the characters in the Preview box look the same 
size, you are probably using too small a size to see
this feature. It works better with large characters
and looks like this:

Characters typed 
uppercase remain the 
same size. Characters typed lowercase are smaller
but in uppercase format — there are no ascenders
(as in the letter t) or descenders (as in the letter p). It
is a nice format for headings and is effective for
acronyms such as USA and UN. It also works well
for A.M. and P.M.

20. Click the Small Caps check box to turn it off.

21. Click the All Caps check box.

Notice that the characters are uppercase in the
Preview box.

22. Click the All Caps check box to turn it off.

Note: When applying Small Caps or All Caps to
characters, you cannot manually change them back
to lowercase since they have been formatted as
uppercase. You have to select the characters and
then turn off the option on the Font dialog box.

Note: The Shadow, Outline, Emboss, and Engrave
options apply distinctive attributes to characters.
Feel free to experiment with them.
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Underline
Options

The Underline style drop-down list box provides Single, Words Only,
Double, Dotted, and other types of underlining. The Underline
button on the Formatting toolbar provides only single underlining.

1. Notice that (none) is chosen in the Underline style
drop-down list box. This is why the text in the Pre view
box is not un der lined.

Click anywhere on the Underline style drop-down
list box. This can be on the word (none), the blank
area to the right of (none), or the down arrow.

Notice the Underline 
style drop-down list box.

2. As mentioned, Single 
underlining is what you used 
when you clicked the Underline 
button on the Formatting toolbar.

Click on Single.

Notice the single underlining in the Preview box.
Also notice that Single is displayed in the Underline
style drop-down list box.

3. Click the Underline style drop-down list box.

4. Choose Words only.

Notice in the Preview box that only the words are
underlined. The space between them is not. You
might prefer this format over single underlining.

5. Click the Underline style drop-down list box.

6. Choose Double.

Notice in the Preview box that the text is
double-underlined.

7. Click the Underline style drop-down list box.

8. Choose Dotted.
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Notice that the text in the Preview box has a dotted
underline.

9. Click the Underline style drop-down list box.

10. Choose (none).

In the Preview box, notice that the text is no longer
underlined.

Color Options The Font color drop-down list box allows you to choose the color of
the text. Unless you have a color printer, however, the text will
print out in black and white.

1. Notice that Automatic is chosen in the Font color
drop-down list box. This will display the default color,
which is usually black. Defaults are discussed later in
this lesson.

Click the Color drop-down list box.

Notice the different colors.

2. Choose Red.

In the Preview box, notice 
that the text displayed is 
red.

3. You are going to change the 
text color back to its default.

Click the Font color drop-down list box.

4. At the top of the drop-down list box, choose
Automatic.

The text in the Preview box is displayed in black
again.

5. You are going to close the dialog box without making
any changes.

Click Cancel.

6. Click anywhere in the document to remove the
highlight.
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The Shortcut
Menu

The Font dialog box can also be accessed through a shortcut menu.

1. Shortcut menus, as you know, are accessed by
right-clicking.

With the pointer anywhere in the document, click
the right mouse button.

2. On the shortcut menu, choose Font.

The Font dialog box appears.

3. Click Cancel to close the dialog box.

Fonts Now that you have already worked with the Font dialog box, you
should learn more about fonts. A font is a typeface. Most fonts are
files, which are stored on disk and transferred to the printer’s
memory. They have names such as Palatino, Arial, Times New
Roman, New Century Schoolbook, and Courier. 

When choosing a font, you also choose the size of the type. Type is
measured in points, a term which usually refers to the height of the
characters. A point is approximately 1/72 of an inch, which means
that 72 point type should be 1" high, 36 point type, ½" high, etc. 

You will need to experiment to find the ideal type size for
particular uses. Classified ads are usually 8-9 point, body text is
often 10-12 point and headlines begin at about 16 point. The width
of the type is relative to its height and is determined by the font
manufacturer. Below is a sample of various font styles and sizes.
Notice that italic and bold has been applied to some of them. You
used these in the Font dialog box. 

This is 20 pt. Arial Bold
This is 10 pt. PalatinoThis is 18 pt. Times New Roman ItalicThis is 16 pt. Freestyle Script
This is 6 pt. New Century Schoolbook

This is 14 pt. Bookman Bold Italic
This is 8 pt. Times New Roman

This is 16 pt. Palatino  Bold
This is 12 pt. Avant Garde
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This is 9 pt. Helvetica ItalicThis is 14 pt. Times New Roman Bold
Changing
Fonts

The same techniques are used to change fonts and font sizes that
are used for all other formats. Namely, if nothing is selected, any
font or font size you choose will be applied to all new text. If
something is selected, the font or size will be applied to the selected 
text only.

You are going to change fonts and font sizes for new text. If you
have only one font available, perform the steps anyway to learn
how to change fonts.

1. Use CTRL/N to open a new document.

2. You can change fonts and font sizes either on the
Formatting toolbar or on the Font dialog box. When you 
use the Font dialog box, you can see an example of the 
font in the Preview box. You will use the Font dialog
box first and then the Formatting toolbar.

On the Format menu, choose Font.

3. Verify that the Font tab is displayed.

Under Font in the upper left corner of the dialog box
is a text box with the name of the current font and a
list box with a list of the fonts available to you. To
the right is a Size text box with the current font size
displayed and a list box of other font sizes. An
example of the current font and font size is
displayed in the Preview box. Because no text is
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selected in the document, the text in the Preview box
is the name of the current font.

4. There are two ways to choose a font on the Font dialog 
box. You can type the name of the font in the Font text
box or you can choose it from the Font list box. The
latter method is usually easier.

Scroll through the Font list box.

The list of fonts currently installed for Windows is
displayed. You may have many fonts or only one,
depending on your printer and whichever fonts
were installed. If the list is long, you will see an
active scroll bar on the right.

Also notice that the fonts are in alphabetical order
and are displayed in their font. (If they are not
displayed in their font, the List font names in their font
item on the Options tab of the Customize dialog box
is not selected.)

5. Click on any font name.

Notice an example of this font in the Preview box.
Because nothing is selected in the document, the
name of the font appears in the Preview box. Its
name is also displayed in the Font text box. It has
been highlighted in the text box so you can easily
replace it with something else.

6. In the Size list box, notice the font sizes available for
the chosen font. The current size is displayed in the
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Size text box. If the list is long, there is an active scroll
bar on the right.

Choose 24 point or something close to it.

Notice the 24 point type in the Preview box. 

7. Continue to choose other fonts and point sizes and 
observe the examples in the Preview box.

8. When finished, click the Cancel button to close the
Font dialog box.

As mentioned, you can also choose fonts and point sizes from the
Formatting toolbar. The lists are identical to those you saw in the
Font dialog box.

1. Notice the current font displayed on the Formatting 
toolbar.

2. Click the down arrow button to 
the right of the current font.

Notice the same list that was displayed on the Font
dialog box.

3. Click the down arrow button to 
the right of the current point size.

Notice the same list as before.

4. Using the Formatting toolbar, choose any font of
your choice and a moderately large font size, such
as 24.

5. Type: This is an example of a different font and point
size.

6. Remember that if text is selected, the font and font size 
will be applied only to the selected text.

Select the sentence you just typed by dragging
over it.

7. On the Formatting toolbar, click the Font down
arrow and choose a font.

8. Click the size down arrow and choose a point size.
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Notice that the font and point size are applied to the
selected text.

9. For practice, spend some time changing fonts and
font sizes to anything you wish both for new text
and for selected text.

Tip: If you select characters with different fonts and
font sizes, the Font and Font Size boxes on the
Formatting toolbar will be empty. You can still
choose a font and size on the Formatting toolbar,
however, and they will be applied to the selected
text.

Note: When you open a new document in these
lessons, we suggest you choose 12 point for the font
size so the characters will be large enough to read
comfortably. The documents on the student disk,
incidentally, use a Times New Roman 12 point font. 

Defaults A default is the setting that Word uses unless you specify otherwise. 
For example, there is a default font and default font size, default
margins and default paper size. There are dozens of defaults that
come with Word when it is purchased. Some can be changed easily 
by a Default button on a dialog box.

The Font dialog box has a Default button. Whenever you change a
default, it is changed for new documents only. Existing documents
are not affected. For example, if you want a 12 point font size for
most of your new documents, choose 12 in the Size box and click
the Default button. Answer Yes when an alert box appears. In the
future, all new documents will use a 12 point font, except in
instances where you change it. After you change a default, it can
always be changed back to its original setting or to another setting.
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More about
Fonts

All Windows applications can access the same printers because
printers are installed for Windows, not for individual applications.
(Installing a printer means supplying Windows with information
so it can work with the printer.) Fonts are installed for Windows
and are available for all applications.

Proportional
and Non-
Proportional
Fonts

Fonts are either proportional or non-proportional. When a
proportional font is used, a letter like w will take up more space on
the line than a letter like i. With a non-proportional font, each
character will take up the same amount of space. Proportional fonts 
have a “type-set” quality. (This manual uses proportional fonts.)
Non-proportional fonts have a “typewriter” look.

mmmmmmmmmmiiiiiiiiiimmmmmmmmmmiiiiiiiiii
The unit of measurement for non-proportional fonts is characters per 
inch (cpi) referred to as pitch. This is possible because all characters
have the same width. Two sizes are often used, 10-cpi and 12-cpi.
They are shown below. There is sometimes confusion because the
higher the cpi number, the smaller the size. This is the opposite of
point sizes, where the higher the number, the larger the size. A
popular non-proportional font is Courier. This is a Courier non-proportional10-cpi font.This is a Courier non-proportional 12-cpi font. 

Serif and
Sans Serif
Fonts

Fonts are also divided into serif and sans serif fonts. Serifs are extra
flourishes at the top and bottom of the letters that help guide the
eye along the line. For this reason, it is a good idea to use serif fonts 
for long passages of text. (This paragraph uses a serif font.) Serif
fonts can also be used effectively for headings. A popular serif font
is Times New Roman. Sans serif fonts (from the French for without
serif) do not have these extra flourishes. Sans serif fonts, therefore,
are usually used only for headings (the headings in this book are a
sans serif font). A popular sans serif font is Arial. A good general
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rule to follow is to use sans serif fonts only for headings, while serif 
fonts can be used for both body text and headings.

1. If you are finished with this lesson, close all open
documents. Other than For mats, which you have
al ready saved, it is not nec es sary to save any other 
doc u ments that you may have opened.

Exercise:
Applying
Character
Formats

You are going to apply character formats to a document named
Credentials. It consists of a short paragraph about an actor's career.

1. Open Cre den tials.

2. On your screen is text that has no character
formats. Following the designations below, apply
the fonts, font sizes and the attributes bold, italic
and underline that are called for. If you do not
have a specified font, pick one of your own.

Actor and Role:  Franklin Gothic Heavy, 18 pt.
Body text:  Times New Roman, 12 pt.
Roles (such as “Li eutenant Easten”):  Bold text
Plays:  Italic text
Stars (Richard Smarmy and Susanne 
Neodin):  Arial 11 pt.
Playwright (Wi l l l iam Hinge):  Arial 11 pt.
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3. When finished, your document should look like the 
following:

4. Close the document. If you think you might want to 
repeat this exercise, do not save the changes.

End of Lesson 9
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GEORGE ZAST (Captain Greer)Over the Edge marks Mr. Zast's Broadway debut. He has
previously appeared Off-Broadway as Lieutenant Easten inWaves wi th Richard Smarmy, General Culthyme in WhoReally Won That War? wi th Susanne Neodin and as ThePrivate in Private Wars and Public Disturbances. Regional
theatre credi ts include: Sergeant Wills in In Service of Love;Ensign Charlie in The Computer Conspiracy wri tten by
William Hinge and Colonel Sums in Witness to the Murder.
When he isn't acting, Mr. Zast works as a temporary word
processing operator for the Mi l i tary Careers Corporation of
America. He dedicates this performance to his mother and
father, Admiral  and Chief Petty Off icer Zast.


